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President’s Message

Hey everyone,

It's hard to believe we're already wrapping up another
year! 2025 has been such a great one for the Saskatoon
Photography Club, and | want to take a minute to thank all
of you for making it so special.

We’ve had some fantastic moments this year — from our
spring photo walk along the riverbank, to all the amazing
guest talks from our speakers, and of course, all the
creative entries in our monthly competitions. The level of
talent in this group keeps growing, and it’s been inspiring
to see everyone pushing their boundaries and sharing
their work.

A big shoutout to all our new members who joined us this
year — welcome to the family! And thank you to our
executive team, board members, and volunteers for all the
time and effort that goes into organizing meetings,
workshops, and events behind the scenes.

As we head into December, | hope you take some time to
enjoy the season (and maybe snap a few snowy shots or
cozy indoor captures). Don’t forget — our December
meeting and year-end social is coming up, so bring a treat
to share and a few of your favorite photos from the year!
Here’s to more creativity, laughter, and great light in 2026.
Wishing you all a safe and happy holiday season — and see
you soon!

Cheers,
Maurice Vold
President, Saskatoon Photography Club


mailto:president@saskatoonphotographyclub.com
tel:+(306)717-3099
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‘A DECEMBER 9, 2025

& You're Invited to Our Annual Christmas Party! &

'Tis the season to be tacky... and tasty!

Join us for a jolly good time at this year’'s Christmas Party, where the theme is all about Potluck Finger
foods & Tacky Christmas Attire. Wear your most outrageous holiday outfit and bring your favorite
bite-sized dish to share!

&= Date: December 9, 2025
® Time: 6:00pm
© Location: Mayfair Church

What to Bring:

e A finger food dish to share (sweet or savory!)

e Your best worst Christmas outfit — Ugly Christmas Sweater, Santa Hats, Reindeer Antlers, Elf
attire, etc.

e We will also have a Christmas Gift Exchange for those that want to participate. The gift can be
new or gently used, with a value around $30.

e Your spouse or a guest (optional)

e Your holiday spirit and appetite for fun!

Prizes will be awarded for:

= lackiest Christmas Attire (People’s Choice)

Most Festive Finger food (People’s Choice)

Voting Results will be shared for the following (voting link will be sent out soon):

e Treasure Hunt - The Letter "G”
e Summer Fun
e Fall Field Trip
Let's eat, laugh, and celebrate the season together.

We can't wait to see you there — in all your festive glory



November 20 or November 28

Exclusive Tour: Historic Photography & Physics Artifacts

Register by clicking the link below

Exclusive Tour: Historic Photography & Physics Artifacts Tickets, Multiple Dates | Eventbrite

Overview

Rare, small-group tour of 1800s-1900s photography & physics equipment. Photograph
artifacts, enjoy a live demo. Only 12 spots per night!

Step Back in Time with the Saskatoon Photography Club!

Join us for a rare, behind-the-scenes tour of the Physics Archival Museum at the University
of Saskatchewan — open to only members of the SPC for a limited time only.

2 Events Only - choose between November 20 or November 28
Both events run from 7pm-8:30pm
Explore an exclusive collection of historic artifacts, including:
o Photography equipment from the 1800s to early 1900s
o Early X-ray machines
o A WWTI aircraft camera
o Rare physics memorabilia from Canada’s scientific past
Limited to just 12 attendees per night for an intimate, immersive experience.

Bonus Feature: The College of Physics will present a live demonstration, specially
arranged for this event!


https://www.eventbrite.ca/e/exclusive-tour-historic-photography-physics-artifacts-tickets-1795654333449?fbclid=IwY2xjawOHNEpleHRuA2FlbQIxMABicmlkETE0WGxVckY1aExiNXEzMnltAR69KQHtrtMe_W5J92BNpUuqzrecO-AT54wjqWJ1evbZ7-lV2hqWx22HmvYW-w_aem_JF6vQVXokVK1hsw5W47hVQ

December 2

AN -

Guest Speaker

PAUL BERARD

“From Photo to Print -

Colour Space Management”
www.saskatoonphotographyclub.com > > > >

; /,
'SASKATOON

PHOTOGRAPH YCLUB

December 9

Christmas Party

PRESENTATION e December 9, 2025

Get together for a potluck supper and party. We will
review the submissions from the Summer Fun, Fall Field

Trip & Treasure Hunt Competitions.



January 6

Guest Speaker |

BRUCE BARNBAUM

“Fifty-Plus Years of Photography”

PH OTOGRAPHY CLUB

www.saskatoonphotographyclub.com > > > >

January 13

A Night at Don’s Photo

PRESENTATION B January 13,2026

A night of learning about prints and gecr at Don’s Photo
(1950 8th Street East]



January 24 - Y ¢

Guest Speaker

DON KOMARECHKA

“Macro Photography”

www.saskatoonphotographyclub.com > > > >

January 27

ANUARY o7

Guest Speaker

~ GARRINE TSANG

“Light Matters”
www.saskatoonphotographyclub.com > > > >



Photography Bingo
Every summer we issue a Bingo Card. By playing Photo Bingo, you will be

challenged to respond to at least 5 categories that are designed to stretch your
creative limits and improve your camera skills. How many categories will you get?

LONG NIGHT FOQD/

TUDY!
EXPOSURE BIMEEING LIGHTS RESTAURANT

STATUES

BRIDGES MURALS WILDLIFE

SPORTS PATTERNS CLOSE UPS

MOTION LIGHT
SELFIE v ACTION i
BLUR PAINTING

NEGATIVE

SYMMETRY SUMMER DOWNTOWN PORTRAIT
SPACE




Treasure Hunt

Great opportunities to go out to take great photos with special categories. Members vote on their favorites.

1. The Letter G
2. Green

3. Gallop

4. Goat

5. Guitar

Submissions: one digital image per topic (set of five images must be submitted)

Deadline: November
Members Vote on Favorites: December (Christmas Party)

Here are Some images from last years Treasure Hunt

1. The Letter F

2. Fire Engine Red
3. Falling

4. Fox

5. Fence



https://saskatoonphotographyclub.com/submissions/
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Snapshot Insights

“It is an illusion that photos are made with the camera... they are

t
Quote made with the eye, heart, and head.” ~ Henri Cartier-Bresson

How to Create a Triptych in Photoshop

A triptych is a three-panel artwork that flows visually or conceptually. It’s perfect
for storytelling, contrasts, or showcasing variations. Here's how to build one from
scratch:

2 Step 1: Prepare Your Images

« Choose three related images: They can be variations of a theme, sequential

moments, or contrasting moods.
. Edit each image individually in Lightroom or Photoshop to ensure consistent

tone, exposure, and color balance.
« Crop to the same aspect ratio (e.g., 2:3 or square) for visual harmony.

e4 Step 2: Create a New Canvas

« Open Photoshop and go to File > New.
« Set the canvas size:
o For horizontal triptych: Width = 3 x image width + spacing; Height =
image height plus top and bottom spacing.
o For this example: For three 16x12 in with 1 inch spacing between
images and around the border:
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Width =12x% 3 =36 in plus 1 inch between and on either side 1x4 =4
Total width 40 inches
o Hight=16 inch + 2 inch =18
« Set Resolution to 300 ppi for print or 72 ppi1 for web.
« Choose Background Color (white, black, or a custom tone). You can change
this later so I usually use white.

Step 3: Place and Align Your Images

« Use Guide Layout to place the images.

o

View > Snap (with this checked photoshop will help snap the image
to the opening)

View > Create new guide layout

Number of columns =3

Gutter = spacing between images

Margins = space around outside of images.



« Drag each image into the canvas as a new layer.
« Use the Move Tool (V) to position them side by side.
o Drag each corner until it snaps into position

12
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¥, Step 4: Choose a Background Color

« Click on the Plus button (1. In image below) to create a new layer and ensure
you drag it above the white background but below your 3 images.

« Click on the layer of the image you want to pick a color from (one of your 3
images) to choose that layer.

« Click on the foreground color panel (2. In image below) and the color panel
(3. In image below) will open so you can to choose a color in the image with
the dropper tool.

« Click on a color in the image you want to try (4. In image below)

« Click on the new layer again to choose it.

« Click on Edit (5. In image below) and choose Fill. When you click fill a
dialog box will come up. Choose foreground color and click OK.

« Repeat this process as many times as you like to create layers with different
colors to see which one you like best.

« Click the eye icon on each layer to make it visible or not so you can compare
with the previous colors.

Untitled-1 @ 16.7% (Layer 3, RGB/16*)

Add to Swatches.
Color Libraries

L 10

Only Web Colors

Craft your vision and edit with your
soul!!

Cheryl Lalonde
PSA Representative
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Photographic

Society of
America

WORLEAIDE

Song Title Winners

The results for the Song Title competition are in from the PSA judge. Here are the links to view the images
and the results/comments.

Results/Comments: Results — Saskatoon Photography Club

Image Gallery: Song Title - saskatoonphotographyclub

First Place
Rocky Mountain High
Richard Kerbes

Score: 30/30

Second Place
Living On The Edge
Barry Singer

Score: 28/30



https://saskatoonphotographyclub.com/results/
https://gallery.saskatoonphotographyclub.com/Clinics/2025-26/Fall-Competition/Song-Title

Third Place
Into the Mystic
Brian Barnhill

Score: 27/30

Honorable Mention
Reflection
June McDonald

Score: 26/30
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i@ Canadian Association For Photographic Art

Canadian Association for Photographic Art (“CAPA”)
Consider a CAPA Membership

The mission of CAPA is to foster a vibrant and inclusive community that promotes ethical practices
and advances the art of photography for all skill levels. We inspire and empower photographers to tell
meaningful visual stories through creativity, education and community.

By joining CAPA, you’ll gain access to a vibrant community and a wide range of member benefits:

« Expert-led education: Participate in workshops, lectures, and series like our CAPA Speaker
Series, Image Critique Nights, Image Editing Demos and other Presentations.

¢ Quarterly magazine: Receive the full-colour, high-quality Canadian Photography
Magazine delivered to your door, along with online access to current and past issues

o Exclusive competitions: Submit your work to eight CAPA-only photography competitions.
You can also explore recent winning entries on our website.

These are just a few of the many benefits you receive when you join CAPA. Joining CAPA is the

best investment in your photography you can make.

Become a member now. https://capacanada.ca/product-category/individuals/ for a full year filled

with learning, competitions, fellowship, new friends and inspiration - that's what we are all about.

CAPA - WHAT’S NEW?

EXCITING NEWS FROM CAPA!

They have just introduced an online Introduction to Judging course that is available for both
CAPA members and non-CAPA members.

Learn how to look at photographs, including your own, with a judges eye.

Gain a better understanding of what makes a good photograph in a variety of genres.

If you are interested in starting down the pathway of becoming a CAPA Certified Judge, these courses
are your first steps.

The course is offered in 3 steps:

1. The Introduction to Judging online course at a cost of $185.00 (with a 35% discount for CAPA
members)

2. Then the Judging Practice Workshop at a cost of $80.00 (with a 35% discount for CAPA
members) and...

3. For those interested in going all the way to become a certified CAPA judge there is a Judges
Certification Program (NOTE: the 3rd step certification program is open only to CAPA
members)

This course is not just for photographers looking to get involved in judging, but also for any
photographer that wants to improve their photography.

This is the link for more information on the Introduction to Judging Course and the link to register.
https://www.capacanada.online/collections/judging

Even if you don't want to take it as far as becoming a certified judge, this is a great opportunity to
learn what makes a great image and how to apply that to your own photography.


https://capacanada.ca/product-category/individuals/
https://www.capacanada.online/collections/judging
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CAPA Monochrome Club Competition Results
The Saskatoon Photography Club entered Six (6) wonderful images to the CAPA Nature Club
Competition. The winning Club was Richmond Hill Camera Club with an aggregate score of 153. Our
total club score was 124.

Each of our entered photographers scored as follows:

Cheryl Lal.onde
Alpha in White — Score of 20.5

Angie Zondervan — Just a Plain Bison
Score of 20.5



Mary Lou Fletcher — Waiting for the Perfect Lunch
Score of 21.5

Jane Hiebert — Eyes on the Prize
Score of 23.5

18



Helen Brown — Spring Beauty
Score of 19.0

June McDonald - Ruggedly at Athabasca Falls
Score of 19.0
Good job photographers! Pretty good scores!

Our next CAPA Club Competition is Monochrome.

19
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Celestial Events - December

Nikon Z6 | 14mm | f/2.8 | 30s | ISO 3200 | 3850K | 158 photos stacked with Star Trails

Celestial Events — December 2025

December is packed with spectacular astronomical events, offering fantastic opportunities for observation and
photography. Mark your calendars and get your cameras ready!

At a Glance
Date(s) Event Name Highlights & Tips
Dec 4 Supermoon (Full Moon) Last Full Moon of the year; appears larger & brighter. Use PhotoPills
to plan your shots.
Dec 7 Moon-Jupiter Conjunction The Moon passes close to Jupiter—great for planetary photos.
Dec 8 Mercury at Greatest Western Mercury visible before sunrise—rare photo opportunity.

Elongation

Peak night for meteor photography; up to 150 meteors/hr. Minimal

Dec 13—-14 Geminids Meteor Shower .
moonlight.

Dec 19-20 New Moon Ideal for star trails and deep-sky objects.
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Date(s) Event Name Highlights & Tips
Dec 21 December Solstice Shortest day in the Northern Hemisphere.
Dec 21-22 Ursids Meteor Shower Another meteor shower with dark skies; peak Dec 22.
Dec 27 Moon-Saturn Conjunction The Moon passes close to Saturn—another planetary highlight.

Event Details & Photography Tips
Supermoon - December 4

e The second and final Supermoon of 2025 occurs at 23:15 UTC. The Moon will be at its closest point to Earth
(perigee), appearing larger and brighter than usual.

e Tip: Use planning apps like PhotoPills to find the best time and location for your Supermoon shots. Try
including foreground elements for dramatic effect.

Moon-Jupiter Conjunction - December 7

e The Moon passes 3.4° north of Jupiter at 15:47 UTC. Both will be bright and close together in the sky.
e Tip: Use a telephoto lens to capture both the Moon and Jupiter in a single frame.

Mercury at Greatest Western Elongation - December 8

e Mercury reaches its greatest separation from the Sun, making it visible just before sunrise.
e Tip: Look to the eastern horizon shortly before sunrise. Mercury is best photographed during these brief
windows.

Geminids Meteor Shower - December 13-14

e The Geminids peak on the night of December 13-14, with up to 150 meteors per hour. The Moon will be
only 28% illuminated, providing dark skies.

e Tip: Use a wide-angle lens and long exposures to capture meteors. Find a dark location away from city
lights. Apps like Meteor Shower Pill can help you plan.

New Moon - December 19-20

e The Moon is completely dark, making this the best time for photographing star trails and deep-sky objects.
e Tip: Experiment with long exposures to capture star trails. The thinnest part of the Milky Way's arch is visible
this time of year.
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December Solstice - December 21

e The solstice marks the shortest day of the year in the Northern Hemisphere and the longest in the Southern
Hemisphere.

e Tip: In the Southern Hemisphere, take advantage of extended golden and blue hours for landscape
photography.

Ursids Meteor Shower —- December 21-22

e The Ursids peak on December 22 at 07:53 UTC, with about 10 meteors per hour. The Moon will be only 5%
illuminated, ensuring dark skies.

e Tip: Use the Meteor Shower Pill or similar tools to check local peak times and moonset. Wide-angle shots
work best for meteor showers.

Moon-Saturn Conjunction - December 27

e The Moon passes 4° north of Saturn at 03:34 UTC. Both will be visible together in the night sky.
e Tip: Capture the conjunction with a telephoto lens or binoculars for a closer view.

Additional Notes

¢ Milky Way: The Galactic Center is not visible at night in December, but you can still photograph the thinner
parts of the Milky Way's arch.

e Star Trails: December’s long nights are perfect for star trail photography. Try stacking multiple exposures for
best results.

e Planning Tools: Apps like PhotoPills and Meteor Shower Pill are invaluable for planning your
astrophotography sessions. They provide local times, moon phases, and meteor shower forecasts.

Glossary

e Supermoon: A full moon that coincides with the Moon'’s closest approach to Earth, making it appear larger
and brighter.

e Conjunction: When two celestial objects appear close together in the sky.

e Elongation: The angular separation between a planet and the Sun as seen from Earth.

e Solstice: The point at which the Sun reaches its most northerly or southerly excursion relative to the celestial
equator.

Clear skies and happy shooting! Share your best shots with the club—we’d love to feature them in our next
issue.
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SHUTTER SHODP

Welcome to the shutter shop. This sectionis reserved for buying
and selling your gear/camera equipment. It is not meant to be for
selling services or advertising businesses. ISO (in search of) is the
equipment wanted section and Flash Sale Finds is the for-sale
section. If you have something to list, please email a description,
1 picture and your contact details to
president@saskatoonphotographyclub.com.

LALD

Flash Sale Finds



mailto:president@saskatoonphotographyclub.com

